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Abstract: This document introduces users to Forms. Forms provide a
better interface for users to enter data into a database and work
with other objects in a database. Participants will learn how to
create Forms via AutoForm and the Form Wizard. They will
also learn how to design and modify forms in design view with
the help of the Toolbox toolbar, add subforms to main forms,
and sort, filter, and work with conditionally formatting data in
forms.
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Introduction

Microsoft Access XP is a relational database management system. This type of database
allows a user to store, retrieve, manage and analyze data quickly and effectively. This
workshop introduces a new database object: forms. Forms allow you to customize your
database interface and help you maintain the integrity of your data.

Objectives

The goal of this workshop is to introduce participants to forms in Access. After today's
workshop, participants will be able to:

* Create a form from a table or query using AutoForm

* Create a form from a table or query using the Form Wizard
* Create a form directly in the Design View

*  Modify a form in the Design View

* Add subforms to main forms

» Sort and filter for records in a form

* Format controls conditionally

Prerequisites

It is assumed that the participants in this workshop are familiar with tables, queries and
relationships in Microsoft Access; have taken Access: Introduction and Access:
Intermediate; or have equivalent skills.

Related Training Available from Instructional Services

All workshops offered by Instructional Services are free to KU students, staff, faculty,
and approved affiliates.

To learn more about or register for workshops, receive automatic announcements of
upcoming workshops, and track workshops you’ve registered for and have attended, visit
www.lib.ku.edu/instruction/workshops. For further workshop related questions, please
email training@ku.edu.

ACCESS: REPORTS

This three-hour, hands-on workshop introduces creating reports via AutoReport and the
Report Wizard. Students will also create and modify a report in design view and learn
how sort, group, format, and perform calculations in a report.

Introducing Forms

In Access, forms can be used to create a friendly data-entry interface to enter information
into tables and/or queries; to create custom dialog boxes to carry out actions; or to create
switchboards for users to open other forms and/or run reports. Bound forms are forms
that are created from other database objects, such as tables or queries. Unbound forms
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are forms created to carry out user’s action, such as opening other forms or running
reports.

Many forms provide a customized interface for you to enter new records into tables and
allow you to format and print individual records. With the help of queries and
relationships, they allow you to enter data into more than one table at a time. Asa
customized interface, fields on a form can offer you a predetermined list of valid values,
which not only ensures consistency from record to record, but also speeds the creation of
new records. In addition, if your database tables are linked with relationships that
enforce referential integrity, forms allow you to look up records and data from the
primary table (main form) and add or edit data in the related table (subform), so you can
easily maintain referential integrity.

Note: Forms can contain bound and unbound controls. A bound control is
one that receives its data directly from a table or query. If the
information in a bound control is changed in a form, it will change in
the table or query. An unbound control is one that is only available in
the form and is not found in a table or query. Labels are unbound
controls.

Using AutoForm

There might be times when you want to concentrate on just one record at a time. Making
an AutoForm can help you do this. When you create an AutoForm, Access will
automatically add all of the fields to the form from the table or query you create the form
from. Here is one way you can create an AutoForm in Access:

1. Click on the Forms button in the object bar in the database window.
2. Click on the New button directly above the object bar.
Qpen lé_f, Design 55| New

3. When the New Form dialog box opens, choose which of the AutoForm options you
want in which to create your new form. The options are as follows:

Design Yiew
—;’ FOYIT] \Wizard

AutoForm: Tabular
AutoForm: Datasheet

This wizard automatically AutoForm: PivotTable

creates a columnar form., AutoForm: PivotChart
Chart Wizard
PivotTable Wizard
Choose the table or query where l ﬂ

the object's data comes from:

| QK | Cancel |
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AutoForm: Columnar: Creates a new form in a column type format for
viewing one record at a time. This is the default format.

AutoForm: Tabular: Creates a form where the fields for each record appears
on one line with the field labels at the top of the form.

AutoForm: Datasheet: Creates a form that has the same datasheet appearance
of a table.

4. Next, click in the drop down list, Choose the table or query where the objects data
comes from:

5. Once you choose the table or query you want to base the form off of, click OK.

6. Access will make the AutoForm and add all of the fields to the form for you.

Creating Forms with the Form Wizard

The Form Wizard is another way to create a form quickly in Access. The Form Wizard
allows you many different options, such as, choosing multiple tables and/or queries to
create a form, selecting which fields you want to appear in the form, choosing the type of
layout you want your form to be in (this includes the three mentioned with the AutoForm
as well as a justified layout), and what kind of background you want on your form. Here
is how to use the Form Wizard:

1. Click on the Forms button on the object bar.
2. Double click Create form by using wizard.

3. Click on the Tables/Queries drop down arrow to choose the first table or query you
want to include in your form.

Note: If you are building a form from a query of related tables with a one-to-
many relationship, the Wizard asks:

* How you want to view your data (in terms of one table or
another)

e How to build the form: A form with a subform or two linked
forms.

4. Under the Available Fields: column on the left side, there are several ways you can
choose to bring a field into the Selected Fields: column on the right:

a) Double click on each field name.
b) Select each field name one at a time, and click on the single arrow button. ;’

c) Ifyou want ALL of the fields, click on the double arrow button. il
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d)

Note: If you want most of the fields in the list, click on the double arrows to

pull them all over. Once they are in the Selected Fields: list on the
right, either double click or click on each field name and click on the
single arrow pointing to the left to send back fields you do not want to
the Available Fields: list on the right. This might save you some
time.

10.
11.

12.

Repeat steps 3 and 4 for each table and/or query.

Click on the Next button.  Mext=
Choose one of the layouts for your form:
a) Columnar

b) Tabular

c) Datasheet

d) Justified

Click on the Next button.

Choose the Style or form background you would like. Standard is the plain gray
background.

Click on the Next button.

Type in the Title you want for your form. This will be the name of the form that will
be displayed in the database window. Click on either one of the following options
you want before clicking finish:

a) Open the form to view or enter information (default).
b) Modify the form’s design.

Click Finish. Access will create your form and open it in the view you chose.

Viewing and Editing
As with all objects in Access, there is a button on the tool bar allowing you to switch
back and forth between Form View (data entry view) of the form ~ and Design View

B - . If you want to make changes to the form, such as changing text in labels, adding
additional labels or controls, deleting controls, or resizing labels or controls, click the

Design View B - button to edit the form.

Creating a Form in Design View

You also have the option to create forms in Design View. This allows you to create the
form from scratch, so that you can choose your fields, formats, and layout your
information however you like.
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To start creating your form in design view you can do the following:
1. Click on the Forms button on the object bar.

2. Click on the New button above the object bar.

3. Inthe New Form dialog box, choose Design View.

4

Click on the drop down arrow beside Choose the table or query where the objects
data comes from: to pick the table or query you want.

Click OK.

6. Your new form will open up into Design View with the Field List displayed.

o1

8 Current_Student @

Enrolled?
Advisor ID
Date admitted
Cumulative hours
Major_ID
School_ID

7. Click and drag on the name of the field that you want to add to the form. It will look
like a block when you drop it onto your form. To add more than one field at a time,
you can use the Ctrl key for non-adjacent fields or the Shift key for adjacent ones.

Microsoft Access - [Form1 : Form]

File Edit Vew Insert Format Tools ‘Window Help

BE-H ak e ER S @gENBE- 0.
Form - - v .
B[N awabl M2 @ F BB @BEES 0B \NOR,

B R O e S R

StudentID
Enrolled?

Advisor ID

Date admitted
Cumulative hours

Major_ID
School_ID

Note: By default, Access creates two controls. The control that is bound to
the table or query that allows the user to input and change information
in the form will appear on the left and a label for that control will
appear on the right. The controls are linked together and can be
moved around the form as a unit.
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8. Repeat step 7 for each field you want to add to your form.

9. Click on the Save button or File=» Save. =

|% Cancel

10. Type the name you want to give to your new form over the default name of Form1.

11. Click on the Form View  button to view, add, or edit the records in your form.

Sections of a Form

When you start to create your form in design view, you first need to figure out where to
place your controls. There a several sections you’ll find in design view of a form. To
turn these sections on choose the word View on the menu bar, and then choose Page
Header/Footer or Form Header/Footer dependent upon which sections you want to
show. Each section has a specific purpose. They are as follows:

Section What it Does

Detail The detail section is used to display records.

Form Header | This section is used for displaying information that remains the
same for every record, such as a title for the form and the date
and/or time. The information in this section appears on your
screen when in Form View, but only appears at the top of the first
page of a printed form.

Form Footer | The form footer is used to display information that is the same for
every record, such as a command button (this could be a button
that is a print record button, which would only print the record
you're on). The information in this section also appears on your
screen when in Form View, but only appears at the bottom of the
last page of a printed form.

Page Header | The page header section can display things such as column
headings or titles. The information in this section will not appear in
Form View. It will only appear at the top of each page when
printed.

Page Footer | The page footer section can display things such as page numbers.
The data in this section will not appear in Form View either. It will
only appear at the bottom of each page when printed.
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Adding and Removing Sections

To add the Form Header/Footer or Page Header/Footer section to your form, you can
do the following:

1. Make sure you are in Design View of your form.
2. Click View=>» Page Header/Footer to turn on those sections.
3. Click View=>» Form Header/Footer to turn on those sections.

Design View

Form View

Datasheet View

PivotTable View

v
LI

PivotChart Yiew

Properties F4
Field List

Tab Order...
Code

Ruler

Grid

Toolbox

Pl <][<] &=

Page HeaderFooter

Header/Footer ‘
Options Form Header Footer [% l

Toolbars > |

[<]

4. Access will place a check beside the sections you turn on.

5. To turn either of those sections off, click on the View menu again, and click on the
name of the one you no longer need.

Note: You can also right click with your mouse on the grid in the Detail
section and click on the name of either section to turn them on or off.

Instructional Services at KU Libraries -9- © 2007 The University of Kansas
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Resizing Sections

Sometimes you might need to make a section larger or smaller. Increasing the size of a
section can allow you to make labels larger or include more fields in your form. To
increase the height of a section, simply place the mouse pointer on the bottom edge of
the section until a double-headed arrow appears with a horizontal perpendicular bar.
Click and drag up or down to increase or decrease the section’s height.

& Form Header

You can also increase the width of all of the sections. To do this, place the mouse
pointer along the right edge of the form’s background (it doesn’t matter which section
because this will adjust the entire width of the form) until a double-headed arrow appears
with a vertical perpendicular bar. Click and drag left or right to increase or decrease the
form’s width.

Adding Controls

Instructional Services at KU Libraries -10 -

In order to be able to view and edit record information in a
form, you’ll need to add controls to your form from the
Field List. The field list contains the fields from the table or
query that your form is based on. To add fields from your Enrolled?
field list, you’ll first have to view the list. You can use the Advisor 1D

Date admitted
field list button to turn your field list on and off. Once, Cumulative hours
the field list is turned on, you are then ready to start selecting  |Major_ID
controls to add to your form.

8 Current_Student @

School_ID

© 2007 The University of Kansas
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Selecting Controls

Whenever you need to rearrange, resize, or format a control in a form, you must first
select the control. You’ll find that there are several different ways to select a control or
multiple controls dependent upon what you need to do. To select a control and/or the
control’s label, simply click one time on the control or the label. To select multiple
controls, try one of the following methods:

* Select the first control, hold the Shift key on your keyboard, and select the remaining
control(s).

* Place your mouse in the vertical or horizontal ruler and watch the white pointer
change to a black arrow. Click and drag in the ruler to select multiple controls.

* Place your mouse anywhere in the dotted grid in the detail section (or whichever
section the controls you’re selecting are in). Click and drag with the mouse to box in
the controls you want. Once you’ve boxed in the controls you want, release the
mouse click and those fields will be selected.

Once the control is selected, small square boxes (also known as handles) will appear
around the outside of the selected control with one large square in the upper left corner.

Resizing Controls

One reason for selecting controls is to resize them. The square black handles around the
outer edge of the control will allow you to resize the control (make it larger or smaller).
Once the control is selected, you can place your mouse pointer on one of these handles.
The pointer will change into a double-headed black arrow that will allow you to click and
drag to resize the field.

3Etudentiy
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Moving Controls
Another reason for selecting controls is to move them. You can move
* Asingle control along with its label.
* Asingle control without its label.
e Multiple controls with their labels

To move a single control along with its label or multiple controls with their labels, you

must use the open hand. When you select the control(s) that you want, along with the

handles a rectangle box will appear around the control. When your mouse pointer is on
one of the lines of the box, the pointer appearance will change to an open hand. When

you see the open hand, you can click and drag and move the control(s) where you want
them to be.

To move a control without its label (or vice versa), when you click on the field to select
it, you will see a large black box (also known as a move handle) appear in the upper left
corner of the field. When you place your mouse pointer over the move handle, the
pointer will change to an upward-pointing hand. You can then drag the control or label
to move it.

Note: If you want to move a control or label to a different section, you will
have to select the control or label you want to move, click on the cut

& button, click anywhere in the background of the section you want

to place the field in, and click on the paste button. The pasted
field will always appear in the upper left corner of the section and
already be selected for you to reposition the field.

Instructional Services at KU Libraries -12 - © 2007 The University of Kansas
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Formatting Controls

Whenever you add controls to your form, you might want to be able to change the font,
font color, size, or etc. The easiest way to do is via the Formatting Toolbar.

- A L[] =-,

However, before you can format the control, you must first select it by click on the outer
edge of the box to select it. Once you’ve done that, the Formatting Toolbar will light
up for you to choose your options.

StudentID v Tahoma v 8 - B I U =

M|
Il

Note: Don’t forget that you can format more than one control at a time.
Simply use one of the selection methods to select all of the controls
you want formatted the same, and then format them.

Other Types of Controls

Sometimes, there might be other types of controls you’ll need to add to your form. Some
of these controls could be combo boxes, check boxes, list boxes, and option groups. In
order to add these types of control, you’ll need to utilize the Toolbox Toolbar. To turn

the toolbox toolbar on and/or off, you’ll want to click on the toolbox button.

Once the button is clicked on, the toolbox toolbar should be displayed.

JEEE B NOR

Button Function

Select objects Clicking on this button returns the mouse to a pointer to allow you
to click on objects and select them.

Control wizards When selected, you can select some other tools from the toolbox
toolbar and a wizard will run.

Label A control that allows you to type in text (like a text box in Word or
PowerPoint).

Text box A control, which will have a label attached to it that allows you to
create bound or unbound fields that could be used to concatenate
fields, do calculations, enter or edit data, or accept user input.

Instructional Services at KU Libraries -13- © 2007 The University of Kansas
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Button

Function

Option group

A frame with a set of options and labels in which the user can
only choose one option. An option group can be bound to a
single field in a table or query. The data type of the field must be
number, and when the option is chosen, Access will store a
number in the underlying table or query that corresponds to the
choice made. Check boxes, toggle buttons, and option buttons
can be used in an option group.

Toggle button

A toggle button can be used to indicate an “On/Off”, “Yes/No”, or
“True False” condition. They can be used within option groups or
as a stand-alone control and be bound to a Yes/No datatype field
in a table or query. When the button is pressed in, it indicates a
Yes, On, or True. When the button isn't pressed in, it indicates a
No, Off, or False. Whichever option is displayed in the table or
guery is determined by the field’'s format property.

Option button

An option button can be used to indicate an “On/Off", “Yes/No”, or
“True False” condition. They can be used within option groups or
as a stand-alone control and be bound to a Yes/No datatype field
in a table or query. When the option button is selected, it
indicates a Yes, On, or True. When the button isn’t selected, it
indicates a No, Off, or False. Whichever option is displayed in the
table or query is determined by the field’'s format property.

Check box

A check box can be used to indicate an “On/Off”, “Yes/No”, or
“True False” condition. They can be used within option groups or
as a stand-alone control and be bound to a Yes/No datatype field
in a table or query. When the box is checked, it indicates a Yes,
On, or True. When the box isn’t checked, it indicates a No, Off, or
False. Whichever option is displayed in the table or query is
determined by the field’'s format property.

Combo box

A Combo box is like a text box and a list box combined. You can
usually either choose an option from the drop-down list in the box,
or you can type in your own, dependent upon the Limit to List
property. Combo boxes can have multiple columns in which one
of the columns is bound to fields in tables or queries, but can also
be bound to SQL statements. You can use unbound combo
boxes to find a record based on the value you select.

List box

A List box can contain multiple columns and is good for short lists
of information. The user can scroll through the list box or choose
one item from a list box. A user cannot type in a list box or
choose an option that’s not there.

Instructional Services at KU Libraries -14 - © 2007 The University of Kansas
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Button

Function

Command button

Command buttons are useful when you want a user to be able to
click, double click, or use the mouse in some other way to make
something happen, such as print a form or look for information
inside of a form. You can use the Control Wizard to take you
through a wizard and help you create a command button or you
can create one on your own using VBA (Visual Basic for
Applications). Access will create an Event Procedure whether
you utilize the wizard or do it manually, and you can always
modify the procedure in the VBA editor as needed.

Image

Used to add pictures to forms and reports. Good for logos and
other types of graphics.

Unbound object frame

Use this tool when you need to add an object to a form or report
and you want to be able to edit the object inside of the form or
report. The information or value from this type of object is not
stored in a table.

Bound object frame

Use this control to display and edit OLE (Object Linking and
Embedding) objects stored in tables.

Page break

When used in forms with Form View, this tool will mark to where
the form scrolls when you use the Page Up and Page Down
keys. Use it to begin a new page on a printed form or report.

Tab control

This tool allows you to insert tabbed pages into your form to
create pages that you can use to help break up your controls.
This is useful when you have a lot of controls to work with that
can be separated into different categories.

Subform/Subreport

Utilize this tool when you want to nest a related form or report
inside of a main form or report. These are helpful when you want
to show data from tables or queries that have a one-to-many
relationship.

Line

Use this tool to draw lines in forms and reports to separate
sections or call attention to certain areas. Use the Shift key to
help keep lines straight when drawing them in.

Rectangle

This tool is for drawing rectangles around a group of controls,
such as when you want to keep them together or group them as
one object. It's also good to use when you want to emphasize
important information in a control.

More controls

This button will take you to more controls that you can use.

Instructional Services at KU Libraries
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Adding Controls from the Toolbox

Dependent upon which type of control you add from the Toolbox toolbar, depends on
whether or not you’ll go through a Wizard. A wizard is a step-by-step process that
prompts you for the information you’ll need to make the control work. For example, say
you want to add a group of options to your form so that a user can only choose from one

Control wizard button to build that type of control.
Maybe you would like to place a subform based from another form or table in the main

form you’ve already created. You can use the Subform/Subreport button along
with the Control Wizards button to aid you in doing this. Having a subform in a main
form is useful because it allows you to enter data into two or more tables from the same
location.

There might be times where you need a title in the form header. Having a title in a form
or report lets others know what the form or report is being used for. Using the Label

A% button is how you can make titles or labels for other objects.

There is also a Text Box 22! button. This button allows you to make controls such as
calculated controls. These can be very useful, especially when you need to add controls
together and have a value returned, but don’t want the value stored in the underlying table
or query.

These are just a few things that the Toolbox can do for you. To use one of these or other
options from the Toolbox, you can do the following:

1. Make sure the Control Wizards button is on or off, as needed.

2. Click on the button that you want to use.

3. Click in the section of the form where you want to place the button.

4

If a wizard appears, follow the prompts of the wizard.

Modifying Properties

Whenever you add controls to a form, you might find you’ll need to change some of the
properties of the controls or the form itself to make it easier to read and use. For
example, you might need to reset the way a user tabs from field to field. In the tab order
box, it can be difficult to decipher which field you want to move if one field says Combo
12 while another field says Combo 15. Changing the Name property in the Property box
for each of the controls can aid in distinguishing between different controls.

To open the property dialog box for a control, simple double click on the control when in
Design or Datasheet View.

Every object in a form will contain properties; therefore, the property box will always
contain the following tabs: Format, Data, Event, Other, and All. However, not all
controls will have the same properties and some of the tabs might not have any
properties, dependent upon which object’s properties you’re trying to see.

Instructional Services at KU Libraries -16 - © 2007 The University of Kansas
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#:" Combo Box: StudentID

|StudentID ~|
Format | pata | Event | other | al |
FOrmat . oo vvveennns | -]
Decimal Places . . .. ...... Auto
ColumnCount . .. ... v v v 3
ColumnHeads.......... Mo
Column Widths . . . ....... 0.7813";0.7188";0.7292"
LiskRows .. ....ovvvnvn 8
ListWidth ., . ........ .. 2.2292"
50 010/1010/0/010/0/0L 01010101010 Yes
Display When . . ......... Always
=2 0/al0'0/0/0/0/0/0/0/0/0/0/0/0/0/0 1.625"
o oaonononooaononan 0.0833"
AN 0 0000000000 00000 1"
MEE e 00000000 aaooac 0.2188"
BackStyle . ............ Mormal
BackColor . ............ -2147483643
Special Effect . ... ... u 0 Sunken

Once you’re finished modifying the properties of a control, you can click on the x in the
corner to close the box. If you simply want to see properties for a different control, you
can locate the control and click on it without having to close the box. The property box
will change to the selected object’s properties automatically.

Note: Not all properties can be modified in Form View. You might have to
switch to Design View instead. You do not have to close the
properties box when switching between views. If you leave it open in
one view, it will remain open when you switch to the other view.
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Setting Tab Control

Once you’ve modified the properties for your controls, you can set the Tab Order for the
form. The tab control is the order in which a user will tab through the form. Here’s how
you can set it.

1. Click on the View menu and choose Tab Order.

Tab Order ?)X]

Click to select a row, or Custom Order:

click and drag to select Major_ID
multiple rows, Drag school ID
selected row(s) to move CLrnilatyS hous
them to desired tab Errolled?

e ey nrolled?

Student Enrollment Subform

| QK I Cancel Auto Order

2. To rearrange the tab order, choose the section that you want to see the controls in.

3. Click on the gray square to the left of the control you want to move.

4. When you click on the gray square again, hold the click down while dragging it to the
location you want it to be.

5. Once you let go of the click, the control will be moved to the new location. Do this
for each control you need to move.

6. When you’re finished changing the tab order, click OK. Change to Form View and
test the tab order by tabbing or entering through a record in your form.
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Sorting and Filtering in Forms

Sorting Information

Whether you’re in a table or form, there are going to be times where you’d like to look at
your data in alphabetical order by a field other than the primary key field. That’s why
Access allows you to use sorting features no matter what object you’re using. Here’s a
quick way to sort in an Access form.

Sorting by One Field (Quick Sort)
To sort by one field in a form, do the following:
1. Place your cursor anywhere in the control on which you want the sort performed.

2. Select Records=>» Sort, and then choose Sort Ascending or Sort Descending. You
Al 2
can also click the Quick Sort “¥ “¥ buttons on the database toolbar. Access sorts

the form based upon the data in the selected column.

3. Toundo a Quick Sort, select Records=» Remove Filter/Sort.

Note: When you close a form, sorted records return to their previous order
unless you save the layout changes.

Filtering Records

One of the basic features of any database is that it should allow you to look at a subset of
your data, based upon some criteria. For example, in an address list, you might want to
only look at address from a particular city or state.

One of the ways of doing this in Access is with filters. When you filter a form in the Form
or Datasheet View, you hide all records that don’t conform to your set of criteria. To
“unhide” the hidden records, you remove the filter.

There are two basic types of filters: the Filter by Selection and the Filter by Form. They
differ in the way you run the filter and the complexity of the filter you can create.
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Filter By Selection

This type of filter is the easiest to perform. It allows you to view all the records in the
form that have the same value in a particular field.

To do a Filter by Selection:

1. Find the value in the control that you want to filter by (e.g., find “Lawrence” in the
City field).
2. Click in once that cell.

3. Choose Records=>» Filter=>Filter by Selection. You can also choose the Filter by
Selection button % from the database toolbar.

Filter By Form

Filter by Form gives you the flexibility to find records based on the values in multiple
fields using the And operator or Or operator, or to use selection criteria to find ranges of
values. Selection criteria are operators and values you enter into the Filter by Form.
Examples of several selection criteria operators include:

> Greater than

>= Greater than or equal to
< Less than

<= Less than or equal to
<> Not equal to

This is an example of selection criteria:

<>66044 This criteria would find all values not equal to 66044.

To use Filter by Form:

1. Click Records=>» Filter=»Filter by Form. You can also select the Filter by Form
button ' on the database toolbar.

2. Inthe Filter by Form mode, you can select unique values from the pull-down menus
for each field, or you can enter custom selection criteria.

3. Ifyou are looking for more than one value in a field, click the Or tab at the bottom of
the Form.

4. If arecord must meet multiple values from different fields, do not click on the Or tab
but instead continue to select or type in the appropriate value for each field. This
uses the implied And operator.

5. Click on Filter=» Apply Filter/Sort or click the Apply Filter button ¥ on the
toolbar.

6. When finished, click the Records menu again and choose Remove Filter or click on
the Remove Filter button ¥,
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Conditional Formatting

Conditional formatting is very useful when you need data that meets certain criteria to
stand out. For example, if you have a document that you only mail to out of state
students, it can be easy to miss some students when there isn’t anything that flags you to
let you know that the student’s record you’re looking at is out of state. It looks the same
as everyone else’s. However, if you were scrolling through student records in your form
and every time you were on an out of state record, the data in the state control was bold
with red lettering and a yellow background, it would be much easier to see. Here’s how
to set up conditional formatting on a field.

Adding a Conditional Format

1. In either Design or Datasheet View, click in the control in which you want to set up

the conditional format.

2. Click on the Format menu and choose Conditional Formatting...

Conditional Formatting

Default Formatting

This Format will be used if no
conditions are met:

AaBbCcYyZz

Condition 1

Fedvaiels 7] |

Preview of format to use when
condition is true:

Mo Format Set

Add => |

3. Inthe first field, select Field Value Is.

a) The other two available options are:

i. Expression Is:

ii. Field Has Focus:

4. Inthe second box, choose the operator you want to use.

5. In the criteria field(s), type in the criteria that the field must meet or not meet for the

format to appear.

6. Set the format you want to see using any or all of the formatting options.

7. If you want to add another criteria, click on the Add>> button. You can set up to

three conditions.

8. Click OK.

As you scroll through the records, look for records that meet the criteria you want. When
you see a record that meets your conditional formatting criteria, the data in the control

should have the format you specified.
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Deleting a Conditional Format

If you find you need to delete a conditional format, you can go back into the Conditional
Formatting dialog box, just as you did when you added them. Once inside, clicking on
the Delete... button will open the Delete Conditional Format dialog box. When you
check the box beside whichever condition you want to delete, click OK, and then click
OK again, the format will be deleted.

Delete Conditional Format

Select the condition(s) to delete:

Cancel

v Condition 1 k

[ Condition 2
[ Condition 3

Getting Additional Help

The Help Desk provides consulting and Q&A help in a variety of ways:

785/864-0200
guestion@ku.edu
www.ku.edu/~helpdesk

Last Update: 12/19/2006

Instructional Services at KU Libraries -22- © 2007 The University of Kansas
A Division of Information Services



